
  

 
 

 
 

 

 
 

AVR8000: ASF Getting Started 

Features 

• Introducing the User Application Template 

• Turning on a LED 

• Setting up the clocks 

• Using delay service to toggle a LED every 500ms 

• Setting up the USART 

 

Prerequisites 

• Knowledge of C programming 

• UC3-L0 Xplained 

• JTAGICE3, JTAGICE mkII, AVR Dragon or AVRONE! 

• AVR Studio 5 

• UC3L064 datasheet 

 

Introduction 

The purpose of this training is to give an introduction to building your first 
application using the AVR Software Framework (ASF).   
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Document Overview 

This hands-on consists of one assignment, split into several different tasks. 

Throughout this document you will find sections with icons. These icons are used to 

identify different sections of assignments and to identify different types of information. 

 Information 
Delivers contextual information about a specific topic 

 Tip 
Highlights useful tips and techniques 

 To do 
Highlights objectives to be completed in italic font 

 Result 
Highlights the expected result of an assignment step 

 Warning 

Indicates important information 

 

Hardware setup 

 Install drivers for the debugger (e.g. JTAGICE3) 
• Before this step Studio 5 should be installed. 

• Plug the USB cable to the PC to power power-up the debugger. 

• The “Found New Hardware” wizard should pop up: 

 

 

• If prompted to check the web, select the “No, not this time” option 

• Click “next” twice to install the software automatically.   

 

 Install UC3-L0 Xplained CDC driver  
• Plug the USB cable to the PC to power power-up the UC3-L0 Xplained. 

• Windows should see the board first as a USB Device and then as a 

Communications Port, before the “Found New Hardware” wizard pops up. 



 
 AVR8000 

 

 
 

 
3 

AVR8000-AVR-02/11 

  

• If prompted to check the web, select the “No, not this time” option 

• Select “Install from a list or specific location” and click “next”.  

• A CDC driver, called avr_cdc.inf, was included in the training resources handed 

out. Point the installer towards the location of where you saved this.  

 

 Start AVR Studio 5 
Start AVR Studio 5 by clicking on icon which was created on your desktop after 

installation, or find the program under:  Start->All Programs-> Atmel AVR Tools -> 

AVR Studio 5.0. 

 

 Connect the Debugger to the Kit 
If you are using the JTAGICE MKII, it should be connected to the UC3-L0 Xplained as 

shown in the picture below.  

 

 
If using the JTAGICE3 it should be connected as follows: 
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 Read a device signature 
• Reading the device signature is a quick way to ensure that the tool chain is 

working correctly.  

• Select AVR Programming on the Tools menu, or click on the AVR Programming 

shortcut button. 

   

 

• At this point you may be asked to upgrade the firmware in your debugger.  You 

can also do this by selecting Tools -> AVR Tools Firmware Upgrade.  

  
 

• In the AVR Tools Firmware Upgrade window click upgrade.   

   
 

• Select AVR Programming on the Tools menu, or click on the AVR Programming 

shortcut button. 

• In the AVR Programming dialog box work from left to right selecting the debugger 

you are using, the device as the AT32UC3L064 and the JTAG interface, then click 

Apply. 

• Then click “Read” next to device ID.  If you can read a device ID communication 

with the UC3L is working correctly (shown below).  
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1 Getting started using a project template 

This is a getting started training with ASF, the AVR Software Framework.  
 
ASF consists of drivers, components and services, software layers designed to help 
simplify your firmware development.  Services and components rely on drivers, which  
are the low level software support for the microcontrollers hardware peripherals.   
 
Our starting point with ASF, where we will add drivers and services to our project, is 
therefore a User Application Template, which contains a board_init( ) function and a 
board definition file for our given development board.   
 
So let’s start a new example project, which in our case will be a User Application 
Template for the UC3-L0 Xplained board.  
 

 
 
 

Start a new project by opening the New Project wizard, select AVR GCC->Atmel 
Boards -> User application template – UC3-L0 Xplained – AT32UC3L064. 
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Give the project a name that defines the project, in this case call it: 
“ASF_Getting_Started”, and press OK.   
 
This is the empty template we are going to use to get started with the ASF. 

1.1 Understanding the User Application Template 

A User Application Template is the bare minimum of files required to start a project 
which works with the ASF application builder wizard.   
 

 
 
On the right of the AVR Studio 5 IDE is the Solution Explorer, where you can see the 
folder structure of the solution and the underlying project.  A solution may be 
comprised of one or more projects.  There is a Properties window below the Solution 
Explorer.   

 
 

All that is in the main.c file of a User Application Template is a board_init( ) 

function call, as well as an asf.h header file include.   
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board_init( ) contains hardware initializing code for available LEDs, buttons and 

other peripherals on this board.  
asf.h includes all the API header files required by ASF for the modules you have 
used in your project.  It is updated every time you add or remove drivers from your 
project.  

1.2 Turning on an LED 

If we look in the solution explorer under asf->avr32, we see that under the “boards” 
folder there is a uc3_L0_xplained folder.   
 
Under the drivers folder there are two folders added, each containing the respective 
drivers for the GPIO and the Interrupt controller (circled in red below).  
 

 
 

This means that these drivers are already added to our project, so we can start using 
them immediately.   
 
Most functions in ASF start with a prefix of “modulename_”, so if we type “gpio_” 
Visual Assist will help us to start using the GPIO.   
 
So we start typing “gpio_” after the “Insert application code here…” comment.    
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Visual Assist gives us a list of potential functions.  

 Type Ctrl+Space for a complete list of Visual Assist completions.  
 
From the Hardware Users Guide of the UC3-L0 Xplained board, we find that we must 
clear the GPIO, to turn an LED on.  (You will find a copy of the UC3-L0 Hardware 
Users Guide, in the training resources folder you were given).  
 

 
 

So the function we are interested in is gpio_clr_gpio_pin( ).  This function both 
configures the GPIO pin as an output and sets the GPIO pin to 0.  We see, from the 
Visual Assist pop out, that this function takes a pin as input. 
 
In the “boards” folder we found a folder uc3_L0_xplained. (asf->avr32->Boards-
>uc3_l0_xplained).  
 

 
 
Open this folder and double click the board file uc3_l0_xplained.h.  You will see that 
all the LEDs, switches UARTS etc on our development board, have been defined in 
this file.  Scroll down until you see the LED defines.   
 

 
 

Let’s use LED0_GPIO, which you can see has been defined as a GPIO pin. So this will 
be the parameter we need to send to our function.  

 
Now add an end guard to our program, in the form of an infinite while loop.  So our 
main now looks as follows: 
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Ensure that the correct debugger is selected, by clicking on the currently selected 

debugger toolbar: . You will then be able to select the debugger 
you are using.   
 

 
 
 
Debugging is one tab of the project properties.   

 Start debugging 
Now start debugging by selecting: Debug -> Start Debugging and Break. 

   
 
A debug session will be started and execution will break at our main function.  
Run the program by pressing F5. Our LED will now be on!   

 Shortcut keys are shown in brackets when you hover your mouse over a 
button. On the last page of this handout, we have included a debugging 
reference, which includes many of the keyboard shortcuts.  

 

Reset your processor (  Shift+F5), then press Step Over (  F10) board_init( ) 

and then Step Into ( F11) gpio_clr_gpio_pin( ).   
 
Now stop debugging by pressing Stop Debugging, from the Debug menu, or click on 

the Debugging Toolbar shortcut button .  

 Quiz 
 
Which line causes the LED to turn on?   
Search in the UC3L datasheet for the OVRC register.  What does this register do? 
(The UC3L064 datasheet is in the training resources folder).  
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 Finding device datasheets in AVR Studio 5 
If you are connected to the internet, you can find device datasheets from within 
AVR Studio 5 as part of the project properties. 
 
To open the properties of a particular project within your solution, click on the 
project name and then the Property Pages icon, circled in red below.  Or right-
click on the project name and select Properties. 

 

 
  
Click on the Device tab on the left. You will then see which device is associated 
with the project and find a link to the datasheet.  
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2 Setting up system clocks 

Let’s now add some code to toggle this LED every half a second.  There is a delay 
service in ASF which can help us add this 500ms delay between LED toggles.  
 
The delay service will work with the UC3L’s default 115kHz RC oscillator, however 
since we will be using the USART later on, let us first configure the system clocks to 
use a faster clock.   
 
This can be done by using the Clock Control service.   

2.1 Adding ASF’s Clock Control service to your project 

This service forms a basis for many applications as it will set up all clocks to our 
specifications. In order to add it to your project, select Project –> Select Drivers from 
AVR Software Framework.  
 

  
 

Select the Timing - Clock Control (Service), by typing “clock” in the search bar, or look 
for it under services dropdown menu. The Clock Control service is shortened to 
“sysclk” when referenced in ASF function names.  
 

 
 
By clicking on the green arrow next to Clock Control, you will see that the Clock 

Control service relies on the FLASH Controller driver (Circle around green arrow ).  
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ASF is aware that the UC3L Flash Controller offers a wait state to allow the UC3L 
CPU to run faster than 30MHz, but the Clock Control module hides this complexity 
from the user.  
 
If you are connected to the internet, you will be able to open module documentation 
for the module you have selected in a browser, by clicking on the help icon circled 

above .  
 

 
 
In the Select Drivers from AVR Software Framework window click Add to selection, 
then next to see which folders and files will be added to your project.  
 

 
 

Notice that relevant header files, such as sysclk.h will be added to your project. Click 
Finish.  
 
Open asf.h, which you will find just above main.c in the Solution Explorer, to verify 
that sysclk.h and flashcdw.h have now been included.  
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2.2 Configuring System clocks to our specifications 

When you open the User application template, there will be a configuration file 
included by default in the config folder: conf_board.h. After adding the Clock Control 
service, this folder will also contain a clock configuration file conf_clock.h.  

 
 
In this example we will, use the Digital Frequency Locked Loop (DFLL) clock module 
of the UC3L to generate the main clock source for our application.  The DFLL can 
give very accurate output, which will be useful later when we configure the USART. 
 
Open conf_clock.h.  Inside this file you will find a list of potential clock options for the 
UC3L.   
 
First we select the DFLL as the system clock source.  This is done by commenting 
out the SYSCLK_SRC_RCSYS default and uncommenting the SYSCLK_SRC_DFLL. 
 

//#define CONFIG_SYSCLK_SOURCE        SYSCLK_SRC_RCSYS 

//#define CONFIG_SYSCLK_SOURCE        SYSCLK_SRC_OSC0 

#define CONFIG_SYSCLK_SOURCE        SYSCLK_SRC_DFLL 

//#define CONFIG_SYSCLK_SOURCE        SYSCLK_SRC_RC120M 

//#define CONFIG_SYSCLK_SOURCE        SYSCLK_SRC_PLL0 

//#define CONFIG_SYSCLK_SOURCE        SYSCLK_SRC_PLL1 
 

Next we uncomment the lines associated with the DFLL configuration.  The DFLL 
takes in three parameters, a clock source to be used as an input, a multiplication and 
a division factor.   
 

//#define CONFIG_DFLL0_SOURCE         GENCLK_SRC_OSC0 

//#define CONFIG_DFLL0_SOURCE         GENCLK_SRC_RCSYS 
#define CONFIG_DFLL0_SOURCE         GENCLK_SRC_OSC32K 

//#define CONFIG_DFLL0_SOURCE         GENCLK_SRC_RC120M 

//#define CONFIG_DFLL0_SOURCE         GENCLK_SRC_RC32K 

 
For the DFLL clock source (CONFIG_DFLL0_SOURCE) let’s use the 32K oscillator 

(GENCLK_SRC_OSC32K), which will have a value of 32768Hz. 
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Now uncomment the lines associated with setting up the DFLL multiplication and 
division factors.  
 

/* Fdfll = (Fclk * DFLL_mul) / DFLL_div */ 

#define CONFIG_DFLL0_MUL            (80000000UL / BOARD_OSC32_HZ) 

#define CONFIG_DFLL0_DIV            2 
 

The multiplication factor, CONFIG_DFLL0_MUL, by default is 80MHz divided by the 

boards 32KHz oscillator frequency of 32768Hz.  The CONFIG_DFLL0_DIV is set to 2, 
giving is a DFLL output frequency of 40 MHz.  Let’s use these default values.  

 DFLL Possible frequencies 
From the UC3L datasheet, we can see that the DFLL is specified to operate 
between 40MHz and 150MHz. The below is an extract from the configuration 
summary of the UC3L, showing the potential clock sources.  

  

2.3 Initializing the Clock Control module 

Every driver we add to our project will need some form of initialization. The usual 
name for the function to call to do this is  

<driver/service name>_init_<sub_mode>(<parameters>).  
 

We can now initialize the clocks we have configured by calling the function 
sysclk_init() from main( ).    
 
Our program should now look as follows.  

 

#include <asf.h> 
 

int main (void) 

{ 
      board_init(); 
      sysclk_init(); 

 
 // Insert application code here, after the board has been initialized. 

      gpio_clr_gpio_pin(LED0_GPIO); 

 
      while(1) { 
      } 

} 

3 Flashing the LED in real world time 

Now that we have configured our clocks, flashing an LED in real world time, every 
500ms is an easy task, by adding the Delay service from ASF to our project.   
 
This is done by selecting Project –> Select Drivers from AVR Software Framework.  
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If we search for delay, we see a Delay Function.  

 
 
 
By clicking on the green Depends On ( ) arrow, we can see that this delay function 
will rely on the CPU Cycle Counter, which is a driver.   
 
Click Add to selection then Finish.  
 
The CPU cycle counter can determine how many CPU cycles have elapsed from one 
point in code to another.  However in order to get time, we still need to know how long 
each cycle takes, i.e. we need to know the CPU clock frequency.   
 
As with sysclk, we now need to initialize the delay service.  The convention is 
repeated below:  
 

<driver/service name>_init_<sub_mode>(<parameters>).  
 

As we start typing: delay_ini… we get the following prompt from Visual Assist: 
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The Visual Assist popout shows us that delay_init() requires as a parameter, the 
CPU frequency in Hz.  There is a convenient function which does this built into sysclk, 
which we can simply call as follows: 
 

delay_init(sysclk_get_cpu_hz()); 

 
Let’s now add a 500ms delay into our while loop as well as a function to toggle the 
LED, we can use gpio_tgl_gpio_pin().  Our code should now look as follows:  
 

#include <asf.h> 

 
int main (void) 

{ 

 board_init(); 
 sysclk_init(); 

 delay_init(sysclk_get_cpu_hz()); 

 
 gpio_clr_gpio_pin(LED0_GPIO); 
 

 while(1) { 

  gpio_tgl_gpio_pin(LED0_GPIO); 

  delay_ms(500); 
 } 

} 

 
When we compile and run the LED should now toggle every 500ms.  
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4 Setting up the USART 

In this section we will be adding basic USART functionality to our board.  
 
We will be setting up our USART with the following parameters: 

baudrate = 57600,  

character length = 8bits,  
no parity,  

1 stop bit 

 
Initially we will test the USART by using a loopback configuration, reading back 
information transmitted on the Tx pin, using the Rx pin.   
 
As an optional exercise we will then configure a terminal program to receive a 
message from the board and to echo characters typed locally.   
 
This section will rely on the DFLL being setup as described in section 2.2. 

4.1 Adding the USART Driver and determining Initialization function 

The USART driver needs to be added to the project following a similar process we 
have used for the other drivers.  
 
Project -> Select Drivers from AVR Software Framework. Type USA…in the search 
bar, then select: USART – Univ. Sync/Async Serial Rec/Trans.  Click Add to 
selection, then Finish.  
 

 
 
We start by initializing the driver. The usual name for the function to call to do this is  

<driver/service name>_init_<sub_mode>(<parameters>).  
 
So we start typing usart_init…, usart_init_rs232( ) is an option, this will be the 

function associated with initializing the USART in RS232 mode which we will use.  
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From the Visual Assist pop out, we can also see the required parameters that we 
need to configure the USART.  Once we have typed the function name, the required 
type of the first input parameter will be shown in bold.  
 

The usart_init_rs232( ) function requires the following parameters: 
1. A pointer to the base address of the USART module 
2. A pointer to an options struct, containing our configuration parameters, of 

type usart_options_t. 
3. The USART module input clock frequency, which will be frequency of the 

peripheral bus it is attached to. 

4.1.1 Base address of the USART module 

We want to use one of the UC3L USARTS. Since module defines in the UC3L start 
with AVR32_, let’s find some options by starting to type &AVR32_ Visual Assist will 
then give us a list of potential modules.   

  
 
To confirm which USART module is available for us on the UC3-L0 Xplained, we 
navigate to the board header file uc3_l0_xplained.h and scroll down to the USART 
section.   
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In this section we will use the USART_USB_BRIDGE as our USART. 
 

Notice that there is an associated #ifdef CONF_USART_USB_BRIDGE.  This means 

that we have to add a define for CONF_USART_USB_BRIDGE in order for the 

USART_USB_BRIDGE section to be defined.  
 

In order to set up the GPIO pins associated with the chosen USART to work as 

USART RXD and TXD pins, CONF_BOARD_COM_PORT also needs to be defined.  The 

below is an extract from board_init():  
 
#if defined (CONF_BOARD_COM_PORT) 
    // USART GPIO pin configuration. 

 
    const gpio_map_t COMPORT_GPIO_MAP = 

        {{ USART_RXD_PIN, USART_RXD_FUNCTION }, 
         { USART_TXD_PIN, USART_TXD_FUNCTION }}; 

 

    gpio_enable_module (COMPORT_GPIO_MAP, 
        sizeof (COMPORT_GPIO_MAP) / sizeof (COMPORT_GPIO_MAP[0])); 
#endif 

 
The configuration file conf_board.h is located in the same config folder as 
conf_clock.h.  Open this file and add the required defines for 

CONF_USART_USB_BRIDGE and CONF_BOARD_COM_PORT,as shown below: 
 

/** 
 * \brief UC3-L0 Xplained board configuration template 
*/ 

 

#ifndef CONF_BOARD_H 

#define CONF_BOARD_H 
 

#define CONF_USART_USB_BRIDGE 

#define CONF_BOARD_COM_PORT 

 
#endif /* CONF_EXAMPLE_USART_H_INCLUDED */ 

 No help for Visual Assist when typing CONF_USART_USB_BRIDGE 
Visual Assist shows you defined options.  Here you are actually defining 

CONF_USART_USB_BRIDGE and CONF_BOARD_COM_PORT.   

 

Add the module address for USART2, USART_USB_BRIDGE, to the 

usart_init_rs232( ) function call followed by a comma.  As you type the comma, 
the second required parameter becomes highlighted in bold. 
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4.1.2 Which USART configuration parameters will we use? 

In order to define our USART configuration options, we need to create an options 
struct of type usart_options_t.  Let’s create a variable of this type, above the 
usart_init_rs232 function, and call it usart_opt.   
 
We can go to the definition of the structure by putting our mouse pointer in this struct 
and pressing Alt+G. 
 
Alternatively we can determine the required parameters by typing our variable name 
and a dot (“.”), which shows us there are five parameters to configure for the UC3L 
USART.  
 

 
 

Notice that the visual assist popout for channelmode shows us the mode options. In 

addition, as we start typing USART_LO…we get another popout: 

   
 

A loopback configuration will be interesting to us in terms of testing our USART. We 

can find the details of what a local or remote configuration entails in the UC3L 

datasheet. Searching for loopback in the UC3L datasheet, the first instance is in the 

USART features section.   
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The test modes supported correspond to the potential channel modes that we get 

from Visual Assist.  We will use the local loopback mode, which is described below: 

 
 

Since we wanted a USART with the following parameters, 

baudrate = 57600,  
character length = 8bits,  

no parity,  

1 stop bit 

 

we can finish populating usart_opt as follows: 

usart_options_t usart_opt; 

 usart_opt.baudrate = 57600; 

 usart_opt.channelmode = USART_LOCAL_LOOPBACK 

 usart_opt.charlength = 8; 

 usart_opt.paritytype = USART_NO_PARITY; 

 usart_opt.stopbits = USART_1_STOPBIT; 

 

Now &usart_opt can be sent to usart_init_rs232( ) as a parameter.   

4.1.3 Getting the peripheral bus frequency 

The last parameter for usart_init_rs232( ) is the bus frequency of the Peripheral 

Bus attached to the specified USART.  Sysclk gives us a built in function called 

sysclk_get_peripheral_bus_hz(), which takes a pointer to a peripheral and 

returns the speed of the bus attached to that peripheral. 

 
 

So our usart initialization is as follows:  

 

usart_init_rs232(USART_USB_BRIDGE,&USART_opt,  

sysclk_get_peripheral_bus_hz(USART_USB_BRIDGE)); 

4.1.4 Turning off unused Module clocks 

The clocks to all the modules on the UC3L are enabled by default.   
 
In conf_clock.h there is a section which can be used for disabling non-essential 
clocks to save power.  Example sysclk module indexes are given.   
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//#define CONFIG_SYSCLK_INIT_CPUMASK  (1 << SYSCLK_SYSTIMER) 

//#define CONFIG_SYSCLK_INIT_PBAMASK  (1 << SYSCLK_USART0) 
//#define CONFIG_SYSCLK_INIT_PBBMASK  (1 << SYSCLK_HMATRIX) 
//#define CONFIG_SYSCLK_INIT_HSBMASK  (1 << SYSCLK_MDMA_HSB) 

 

If we were to uncomment the define associated with the PBAMASK, sysclk would 
then turn off non essential peripherals on that bus, except for the modules explicitly 
specified.  Lets uncomment and all of these masks and define them to 0, in order to 
turn off all non-essential peripheral clocks in our device.  This can be used to save 
power.   
 

#define CONFIG_SYSCLK_INIT_CPUMASK  0 

#define CONFIG_SYSCLK_INIT_PBAMASK  0  

#define CONFIG_SYSCLK_INIT_PBBMASK  0  

#define CONFIG_SYSCLK_INIT_HSBMASK  0  

 

We now use sysclk_enable_peripheral_clock() in order to turn on the clock to our 
USART before use in the main application code.  
 

 sysclk_enable_peripheral_clock(USART_USB_BRIDGE); 
 

The above function should be inserted above usart_init_rs232().  

4.2 Writing to and reading back data from our USART 

Functions usart_putchar() and usart_getchar()are available to us in ASF in 

order to send and receive data from the USART.   

 
As with many of the functions we have used, usart_putchar() takes in the base 

address of the USART instance, as well as a character to write. Let’s send 0x44 as 

our test byte.   

usart_putchar(USART_USB_BRIDGE,0x44); 
 

To receive the character we have transmitted, we will use usart_getchar(), 

however we first need to create a variable of type uint8_t, to store this received data 

in.  We put this above main() to make it a global. 

4.3 Testing the USART 

Your code should now look as follows: 

#include <asf.h> 
uint8_t data; 
 

int main (void) 

{ 

 board_init(); 
 sysclk_init(); 

 delay_init(sysclk_get_cpu_hz()); 
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 usart_options_t usart_opt; 

 usart_opt.baudrate = 57600; 

 usart_opt.channelmode = USART_LOCAL_LOOPBACK; 
 usart_opt.charlength = 8; 
 usart_opt.paritytype = USART_NO_PARITY; 

 usart_opt.stopbits = USART_1_STOPBIT; 

 

sysclk_enable_peripheral_clock(USART_USB_BRIDGE); 

 usart_init_rs232(USART_USB_BRIDGE,& usart_opt,  

sysclk_get_peripheral_bus_hz(USART_USB_BRIDGE)); 
  

// Insert application code here, after the board has been initialized. 

usart_putchar(USART_USB_BRIDGE,0x44); 
data = usart_getchar(USART_USB_BRIDGE);   

 

 gpio_clr_gpio_pin(LED0_GPIO); 
 
 while(1) { 

  gpio_tgl_gpio_pin(LED0_GPIO); 

  delay_ms(500); 

 } 
} 

 

Click the Start Debugging icon  (or press F5).  The processor will enter debug mode 
and halt at the first breakpoint.  You will see that data has a value of 0.  

 

In order to test the USART put a breakpoint on usart_putchar() as well as 

gpio_clr_gpio_pin(LED0_GPIO), as indicated below. Add the data variable to a 

Watch window, by right-clicking and selecting Add Watch.  

  
 
 
Press the green arrow again.  The processor will halt at the second breakpoint, you 
should see that data now has a value of 0x44 in the watch window. 
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Depending on your settings, the decimal value 68 may also be shown.  

We have successfully configured the USART and tested this using a loopback 

configuration by writing to and reading back a byte of data.  

4.4 Configuring a USART terminal 

Since we now know that our USART is configured correctly, let us write a string of 
characters to the USART.  We will first need to change our USART configuration from 
USART_LOCAL_LOOPBACK to USART_NORMAL_CHMODE. 
 
Then we can write a line of data, using the usart_write_line() function.  

 
 

//usart_putchar(&AVR32_USART2,0x44); 
//data = usart_getchar(&AVR32_USART2); 

 

usart_write_line(USART_USB_BRIDGE,"Hello, this is the AVR UC3 MCU saying" 

   " hello!\n"); 

 Ensure that you comment out the lines which we used to test the loopback.  
usart_getchar() will be blocking if it receives no character. 

 Shortcut to uncomment lines of code 
To uncomment lines of code, select the line(s) and press “/”.  
 

You are now ready to attempt to communicate to a terminal program on your PC.  

We will be using the USB USART bridge on the UC3-L0 Xplained, which will require a 

USB Communications Device Class (USB CDC) driver to be installed on your PC 

computer.  This was covered at the start of the training in the Hardware Setup.  
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Once the driver is installed correctly, you will see the board as a com port in your 

computers Device Manager. It will typically be the higher number COM port.  Open 

the COM port properties to check that the location says: XPLAINED CDC.  

Now set up Hyperterminal (Start>All Programs >Accessories> Communications> 

Hyperterminal) or an equivalent terminal program, with the following settings, by 

clicking Configure, once you have the correct COM port selected.   

 

 Alternative terminal program 
An alternative terminal program Bray’s Terminal, has been distributed with the 
training resources. For Windows 7, Hyperterminal is no longer installed by 
default.   
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Once the COM port is configured, connect.  When you run your project, you will now 

get the following message. 

 
 

4.5 Opening the Solution/Example project 

There is an example project USART Example 2, in Studio 5, that has almost the 
same functionality that we have shown so far.  Let’s open this project in order to 
compare this example with our own project.  
 
Exit debug mode, then open this example project within your project solution, by 
going to the Start Page.  
 

 
 
Click New Example Project, navigate to the example projects for the UC3-L0 
Xplained, then select USART Example 2.  Give it a name of 
ASF_Getting_Started_USART, then ensure that Add to Solution is selected in the 
New Example Project wizard as shown below. 
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There are small differences between USART Example 2 and the project we have built 
up.   
 

The usart_options_t struct is created above as opposed to within main(), as we 

have done.  In addition the example uses a function usart_get_echo_line(), to 

echo received characters. 
 

 
 

Add the following lines of code to your project after usart_write_line(). The 
message to the user has been extended to give more information to the user about 
the new functionality we have added. 
 
usart_write_line(USART_USB_BRIDGE,"Hello, this is the AVR UC3 MCU saying" 

 " hello! Type to echo characters, then when you are finished press 

ENTER\n"); 

 
do { } while (usart_get_echo_line(USART_USB_BRIDGE) == USART_FAILURE); 
usart_write_line(USART_USB_BRIDGE, "Goodbye.\n"); 

 
If you type “Hello UC3-L0 Xplained...how are you doing today?”, then press enter, the 
following will be the terminal output.  
 

 
 

4.6 Modifying USART Example 2 

Let us modify USART Example 2, to use the same USART we have been using 
USART_USB_BRIDGE.  Add also the following defines in the conf_board.h. 
 

#define CONF_USART_USB_BRIDGE 

#define CONF_BOARD_COM_PORT 
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You will also need to modify conf_example_usart.h, to specify the correct USART, 
you will find this file in the config folder in the Solution Explorer.  
 
Change EXAMPLE_USART from USART_J4 to USART_USB_BRIDGE, as shown 
below.   
 
#ifndef CONF_EXAMPLE_USART_H_INCLUDED 

#define CONF_EXAMPLE_USART_H_INCLUDED 

 

#define EXAMPLE_USART        USART_USB_BRIDGE 
#define EXAMPLE_USART_BAUD   57600 

 

#endif /* CONF_EXAMPLE_USART_H_INCLUDED */ 

 

 
You should now be able to run USART Example 2 and get the same terminal output.  
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Studio 5 Debug Control Summary 

The following table can be found in Studio 5 help, under: Debugging in Studio 5. Full 

descriptions are provided there about each step.  
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